DATA COLLECTION GUIDE

2019 Adolescent Mental Health and/or Depression Screening
(01/01/2018 to 12/31/2018 Dates of Service)

Data Submission: 04/01/2019 to 05/10/2019
# Table of Contents

Preface .................................................................................................................................................. i

Summary of Changes .............................................................................................................................. ii
  A. Measure Specification Changes from Previous Year ................................................................. ii
  B. Field Specification Changes from Previous Year ........................................................................ ii
  C. Other Changes from Previous Year ............................................................................................. ii
  D. Other Changes from Previous Year ............................................................................................. ii

Measure Specifications ....................................................................................................................... iii
  Measure Logic / Flow Chart ............................................................................................................... v

Process and Timeline Overview ........................................................................................................ vi

Data Submission Resources ............................................................................................................... vii

Section I: Agreements and Pre-Submission Data Certification ........................................................... 1
  A. Business Associate Agreement .................................................................................................. 1
  B. Direct Data Submission Terms and Conditions ...................................................................... 1
  C. Data File Transfer Selection ..................................................................................................... 2
  D. Pre-Submission Data Certification .......................................................................................... 3

Section II: Data Collection .................................................................................................................. 4
  A. Eligible Population Identification ............................................................................................. 4
    Total Population (recommended) .................................................................................................. 4
    Sample Population ....................................................................................................................... 4
    Patient Attribution ...................................................................................................................... 5
  B. Data Collection .......................................................................................................................... 6
    Data Elements and Field Specifications ..................................................................................... 6
  C. Data Quality Checks .................................................................................................................. 11

Section III: Data Submission .............................................................................................................. 12
  A. Data File Creation ...................................................................................................................... 12
  B. Data Submission ........................................................................................................................ 13
    Data Submission ........................................................................................................................ 13
    Denominator Entry Field Specifications ..................................................................................... 13

Section IV: Data Validation ................................................................................................................ 18

Appendices ......................................................................................................................................... 20
  Appendix A: About Direct Data Submission ............................................................................... 20
  Appendix B: Sampling Methods .................................................................................................... 22
  Appendix C: Mental Health/Depression Instruments and Descriptions ..................................... 24
    Table 1: Depression only screeners – Highly Recommended and Public Domain .................... 24
    Table 2: Depression only screeners – Highly Recommended and Proprietary ....................... 25
    Table 3: Depression only screeners – Acceptable but Not Highly Recommended and Public Domain .................................................................................................................. 26
    Table 4: General mental health screeners – Highly Recommended or Proprietary with Permission in MN ........................................................................................................................ 27
  Appendix D: Glossary of Terms ..................................................................................................... 28

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2018. All rights reserved.
Preface

Dear Data Submitters,

Attached is our 2019 Adolescent Mental Health and/or Depression Screening Data Collection Guide. We truly appreciate your medical group contributing data on quality and patient outcomes. Your involvement is vital to MN Community Measurement’s ability to achieve our mission to empower health care decision makers with meaningful data to drive improvement.

We want to support your success as well by providing resources, tools and reports that your medical group or clinic can use for quality improvement.

The following resources can be found on our corporate website, MNCM.org:

- Public reports including the Health Care Quality Report, Health Equity of Care Report, Health Care Disparities Report, Total Cost of Care Report, and topic specific reports released throughout the year
- Patient education and engagement resources
- Provider tools and resources
- Educational webinars throughout the year
- Health Trackers

Additionally, the following resources can be found on the secure MNCM Data Portal:

- Detailed reports and charts of clinical measure results
- Charts of specific clinical measure results segmented by race, Hispanic ethnicity, preferred language and country of origin (REL) for medical groups following best practices

Finally, on MNHealthScores.org, you will find public-facing results of all measures for clinics, medical groups and hospitals. As this is our consumer-focused site, it has less detail than is available in our reports and on the Data Portal.

MNCM is committed to working with multi-stakeholder committees to champion the highest value measures that will make the most impact in our community, while minimizing burden on organizations that supply the data. And as performance results improve, we have processes in place to retire measures as appropriate.

Thank you again for your important role in our work. If you have questions, feel free to contact us at 612-746-4522 or support@mncm.org.

Anne Snowden, MPH, CPHQ
Director, Performance Measurement & Reporting

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2018. All rights reserved.
Summary of Changes

A. Measure Specification Changes from Previous Year
   1. Added clarifying language to Eligible Population Event and Required Exclusions.

See Measure Specifications for further detail.

B. Field Specification Changes from Previous Year
   1. Language regarding Patient Sex updated for clarity (Column D).

See Data Elements and Field Specifications table for further detail.

C. Other Changes from Previous Year
   NONE

D. Other Changes from Previous Year
   1. Measure name modification from Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening to Adolescent Mental Health and/or Depression Screening.
   2. Minor edits to Preface cover letter.
   3. Removal of instructions to complete Pre-Submission Quality Checklist (Sec III-B).
# 2019 Adolescent Mental Health and/or Depression Screening Measure Specifications

## Measure Specifications

<table>
<thead>
<tr>
<th>Summary of Changes</th>
<th>Added clarifying language to Eligible Population Event and Required Exclusions.</th>
</tr>
</thead>
</table>

## Description

The percentage of patients 12-17 years of age who were screened for mental health and/or depression

## Measurement Period

January 1 through December 31, 2018

## Eligible Population

### Eligible Specialties

- Family Medicine, Internal Medicine, Pediatric/Adolescent Medicine

### Eligible Providers

- Medical Doctor (MD), Doctor of Osteopathy (DO), Physician Assistant (PA), Advanced Practice Registered Nurses (APRN)

## Ages

12 years or older at the start of the measurement period AND less than 18 years at the end of the measurement period

## Event

At least one face-to-face well child visit *(Adolescent Well Child Visit Value Set)* performed or supervised by an eligible provider in an eligible specialty during the measurement period

## Denominator

The eligible population

## Numerator

The number of patients in the denominator who completed ANY of the following mental health and/or depression screening tools during the measurement period, AND have the screening tool result documented in the medical record:

- Patient Health Questionnaire – 9 item version (PHQ-9)
- PHQ-9M Modified for Teens and Adolescents
- Kutcher Depression Scale (KADS)
- Beck Depression Inventory II (BDI-II)
- Beck Depression Inventory Fast Screen (BDI-FS)
- Child Depression Inventory (CDI)
- Child Depression Inventory II (CDI-2)
- Patient Health Questionnaire – 2 item version (PHQ-2)
- Pediatric Symptom Checklist – 17 item version (PSC-17) - parent version
- Pediatric Symptom Checklist – 35 item (PSC-35) - parent version
- Pediatric Symptom Checklist – 35 item Youth Self-Report (PSC Y-SR)
- Global Appraisal of Individual Needs screens for mental health and substance abuse (GAIN-SS)
### 2019 Adolescent Mental Health and/or Depression Screening Measure Specifications

<table>
<thead>
<tr>
<th>Required Exclusions</th>
<th>The following exclusions must be applied to the eligible population:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Patient had a diagnosis of schizophrenia (<em>Schizophrenia</em> Value Set) any time prior to the end of the measurement period</td>
</tr>
<tr>
<td></td>
<td>• Patient had a diagnosis of bipolar disorder (<em>Bipolar Disorder</em> Value Set) any time prior to the end of the measurement period</td>
</tr>
<tr>
<td></td>
<td>• Patient had an active diagnosis of depression or dysthymia (<em>Major Depression or Dysthymia</em> Value Set) any time during the measurement period</td>
</tr>
<tr>
<td></td>
<td>• Patient had a diagnosis of personality disorder (<em>Personality Disorder</em> Value Set) any time prior to the end of the measurement period</td>
</tr>
<tr>
<td></td>
<td>• Patient had moderate, severe or profound intellectual disabilities (<em>Intellectual Disability</em> Value Set) any time prior to the end of the measurement period</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Measure Scoring</th>
<th>Rate/Proportion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interpretation of Score</td>
<td>Higher score indicates better quality</td>
</tr>
<tr>
<td>Measure Type</td>
<td>Process</td>
</tr>
</tbody>
</table>
2019 Adolescent Mental Health and/or Depression Screening Measure Specifications

**Measure Logic / Flow Chart**

1. **Is the patient’s date of birth between 01/01/2001 to 01/01/2006?**
   - Yes
   - No

2. **Does the patient medical record have documentation of any diagnosis which requires exclusion from the measure?**
   - Yes
     - **PATIENT NOT INCLUDED IN MEASURE**
   - No

3. **Was the patient seen by an eligible provider in an eligible specialty during the measurement period (01/01/2018 to 12/31/2018) for at least one face-to-face well child visit (Adolescent Well Child Visit Value Set)?**
   - Yes
     - **PATIENT INCLUDED IN DENOMINATOR**
     - **Was the patient administered an accepted mental health and/or depression screening tool during the measurement year?**
       - Yes
         - **PATIENT NOT INCLUDED IN NUMERATOR**
         - **Is the result of the administered screening tool documented in the patient medical record?**
           - Yes
             - **PATIENT INCLUDED IN DENOMINATOR**
           - No
             - **PATIENT NOT INCLUDED IN NUMERATOR**
       - No
         - **PATIENT INCLUDED IN DENOMINATOR**
# Process and Timeline Overview

<table>
<thead>
<tr>
<th>Process Step</th>
<th>Important Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Registration</strong></td>
<td>November 2018 to February 2019.</td>
</tr>
<tr>
<td>Registration must be completed prior to data submission. Please refer to the <a href="#">Clinic and Provider Registration Instructions</a> guide available on the Resources tab of the <a href="#">MNCM Data Portal</a> as well as on <a href="#">MNCM.org</a> for additional information.</td>
<td></td>
</tr>
<tr>
<td><strong>Pre-Submission Data Certification</strong></td>
<td>Submit document by April 1, 2019.</td>
</tr>
<tr>
<td>See Section I for more information.</td>
<td></td>
</tr>
<tr>
<td><strong>Data Collection and Submission</strong></td>
<td>MNCM Data Portal is open for submission April 1 to May 10, 2019.</td>
</tr>
<tr>
<td>See Sections II and III for more information.</td>
<td></td>
</tr>
<tr>
<td><strong>Data Validation</strong></td>
<td>April-July 2019.</td>
</tr>
<tr>
<td>See Sections III-B and IV for more information.</td>
<td></td>
</tr>
<tr>
<td><strong>Two-Week Medical Group Review Period of Preliminary Statewide Results</strong></td>
<td>July 2019.</td>
</tr>
<tr>
<td>See Section IV for more information.</td>
<td></td>
</tr>
<tr>
<td><strong>Final Data Results</strong></td>
<td>August 2019.</td>
</tr>
</tbody>
</table>

### Sharing Data Files and Protected Health Information (PHI) Securely:

It is important that data files and PHI are shared securely between organizations. Email is not a secure mode of transmitting data.

- Do not send a data file or patient list that contains PHI to MNCM via email.
- Do not include any identifiable patient information in the body of an email message.
  - Examples of PHI include (but are not limited to) the following: patient ID, patient date of birth, patient name, patient address or zip code, insurance member ID, dates of service.

Please contact [support@mncm.org](mailto:支持@mncm.org) to determine a secure mode of transmission.
Data Submission Resources

The Adolescent Mental Health and/or Depression Screening resources page contains useful documents and answers to Frequently Asked Questions. To access the resources page:

1. Log in to the MNCM Data Portal.
2. Click on the Resources tab.
3. Select **Cycle B – Adolescent Mental Health and/or Depression Screening** from the drop down menu.
   
   a. Download the following documents:
      
      i. *Adolescent Mental Health and/or Depression Screening 2019 Data Collection Guide*
      
      ii. *Adolescent Mental Health and/or Depression Screening 2019 Pre-Submission Data Certification Form*
      
      iii. *Adolescent Mental Health and/or Depression Screening 2019 Data Collection Spreadsheet Template*
      
      iv. **Optional:** *Adolescent Mental Health and/or Depression Screening 2019 Data Collection Form*. This is a patient-level form that is most useful for medical groups and clinics using paper records.
      
      v. *2019 Adolescent Mental Health and/or Depression Screening Value Set Dictionary*. This workbook contains all Value Sets referenced in this guide.

For questions not answered by the information available on the Resources tab, contact MNCM at support@mncm.org or 612-746-4522.
Direct Data Submission
Process Steps
for
2019 Adolescent Mental Health and/or Depression Screening
Clinic and provider registration as well as the electronic signing of the Business Associate Agreement (BAA), the Direct Data Submission (DDS) Terms and Conditions, and selection of a Data File Transfer option must be completed prior to data submission.

A. Business Associate Agreement
A business associate is a person or entity that performs certain functions or activities that involve the use or disclosure of PHI on behalf of, or provides services to, a covered entity. The HIPAA Privacy Rule requires that a covered entity obtain satisfactory assurances from its business associate that the business associate will appropriately safeguard the PHI it receives on behalf of the covered entity. Since MNCM is performing services on behalf of medical groups submitting data that involve the use and disclosure of PHI, it is necessary for covered entities submitting PHI to MNCM to sign a BAA.

To electronically sign the BAA:
1. Log in to the MNCM Data Portal.
2. Click on the Home tab.
3. Click on the BAA Agreement link under the Adolescent Mental Health and/or Depression Screening measure heading.
4. Review the text, click the check box at the bottom of the Agreement and click OK.
   a. Once electronically signed, the Agreement applies to all DDS measures and does not need to be signed again unless provisions of the Agreement change.
   b. Failure to electronically sign the Agreement will preclude the medical group from submitting data.

B. Direct Data Submission Terms and Conditions
Please see Appendix A for detailed information about the DDS Terms and Conditions.

To confirm agreement with the DDS Terms and Conditions:
1. Log in to the MNCM Data Portal.
2. Click on the Home tab.
3. Click on the DDS Terms & Conditions link under the Adolescent Mental Health and/or Depression Screening measure heading.
4. Review the text, click the check box at the bottom of the DDS Terms and Conditions and click Select.
   a. Failure to agree to the DDS Terms and Conditions will preclude the medical group from submitting data for the measure.
C. Data File Transfer Selection

Beginning in 2014, the Minnesota Department of Health (MDH) has requested the receipt of patient level data. MDH has assured MNCM that medical groups are permitted to disclose this patient-level data to MDH under applicable law (including Minnesota law and HIPAA), because it will be used by MDH only for public health activities, health oversight activities, or other activities required or authorized by state or federal law. A list of the data elements to be shared with MDH for each measure is available in the MNCM Data Portal under the Resources tab by selecting Minnesota Statewide Quality Reporting and Measurement System from the drop-down menu.

MDH will use patient level data to:

- Research and analyze health disparities
- Design and evaluate public health interventions
- Publicly report summary results
- Research risk adjustment methodologies
- Benchmark and evaluate Health Care Homes
- Validate quality measure results

MDH will not use patient level data to pursue investigatory or regulatory activities.

Medical groups must indicate on the MNCM Data Portal whether they choose to allow MNCM to share patient-level data with MDH.

1. Log in to the MNCM Data Portal.
2. Click on Data Files Transfer on the Home tab in the MNCM Data Portal under the Adolescent Mental Health and/or Depression Screening section.
3. Choose one of the two data sharing options:
   - YES – My organization agrees to have MNCM share our patient-level data with MDH for specified measures.
   - NO – My organization does not agree to have MNCM share our patient-level data with MDH.
3. Click Save.

If a selection error is made, please contact MNCM at support@mncm.org to request a selection change.
D. Pre-Submission Data Certification

Prior to data collection, medical groups must supply query source code and/or methodology for identifying the correct eligible patient population. This ensures groups are applying the measure specifications correctly. A template document is provided in the MNCM Data Portal Resources tab. The responsibility of applying the measure specifications correctly rests with the medical group.

To download and complete the template and submit it for certification:

1. Login to the MNCM Data Portal.
2. Under the Resources tab, select Cycle B – Adolescent Mental Health and/or Depression Screening from the drop-down menu.
3. Download the Adolescent Mental Health and/or Depression Screening Pre-Submission Data Certification Form.
4. Complete and save the form.
5. Login to the MNCM Data Portal and from the Home page click on Denominator Certification under the Adolescent Mental Health and/or Depression Screening header. Follow the instructions to upload the saved form to the MNCM Data Portal.

MNCM will review the information and will either (1) contact the medical group if more clarification is needed or (2) certify the methodology. An automatic e-mail will notify the medical group when the method is certified.
Section II: Data Collection

A. Eligible Population Identification

After Pre-submission Data Certification is complete, medical groups identify the eligible population. This step must be completed regardless of whether the group plans to submit total population or a sample of eligible patients. Save all original queries, spreadsheets and other documentation of the process used to identify the eligible population. This information may be requested during validation.

Preparing the eligible population list:

1. **Query** applicable systems to generate a list according to the eligible population
2. **Remove** patients from the list who meet any of the criteria described in the required exclusions section of the measure specifications.
   - Exclusions with corresponding diagnosis codes/value sets can be identified by querying the diagnoses associated with encounters.
   - The problem list may be utilized as a source of exclusion diagnoses as well, but it is not required to do so.
3. **De-duplicate** the list; include only one record for each patient.
   - If a patient is listed more than once within a clinic or medical group, determine which provider or clinic the patient will be attributed to and delete the other records/rows within the data file.
   - Organizations with more than one registered medical group must report patients within each medical group for which the patient has met eligibility criteria; duplication of patients across the organization is possible and expected.
   - See Appendix D for the definition of medical group.
4. **Review** the number of patients in the population and consider whether the number is accurate. If not, correct the methodology and/or query.

Total Population (recommended)

Per the EMR Reporting Rule established by the Minnesota Department of Health (MDH), clinics that have had an Electronic Medical Record (EMR) or Electronic Health Record (EHR) in place at any stage for the last two measurement periods are required to submit data on their total population. MNCM strongly encourages all clinics to submit data on their total eligible population, when possible. Benefits include:

- **More reliable performance scores.** Performance measurement scores based on total population data more reliably reflect the quality of care delivered by a clinic and medical group. As the population size in a data submission increases, the margin of error for reporting differences in performance narrows.

Sample Population

Submission of a sample population for this measure is allowed for clinics that do not have an EMR or have had an EMR in place for less than two years. See Appendix B for instructions on identifying a

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login

© MN Community Measurement, 2018. All rights reserved.
random sample of patients. A sample size of at least 60 records per clinic is required. Clinics with 60 or less eligible patients must submit data for the total population.

**Patient Attribution**

Each patient is attributed to the provider and clinic associated with the most recent well-child visit during the measurement period.

If a provider has left the clinic/medical group, the patient must remain in the data file if they meet eligibility criteria.
B. Data Collection

Data Elements and Field Specifications
Use this section to build your data file for submission. The specifications contain detailed information regarding each column in the submission file, including column order, definitions, examples, and appropriate formatting.

<table>
<thead>
<tr>
<th>Column</th>
<th>Field Name</th>
<th>Notes</th>
<th>Excel Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Clinic ID</td>
<td>Enter the MNCM Clinic ID of the clinic to which the patient is attributed based on the attribution methodology detailed in Section II. MNCM assigns clinic IDs at the time of registration. Clinic IDs are listed in the MNCM Data Portal on the Clinics tab. Do NOT use the medical group ID. <strong>Data Portal Note:</strong> A blank field will create an ERROR upon submission. <strong>Quality Check:</strong> Verify that the ID in each cell matches the clinic ID in the MNCM Data Portal.</td>
<td>Text</td>
<td>9999</td>
</tr>
</tbody>
</table>
| B      | Patient ID | Enter a unique patient ID to identify each patient.  
- The patient’s medical record number may be used.  
- Medical groups or clinics that choose not to use the medical record number should:  
  o NOT use the patient’s Social Security Number  
  o Maintain a crosswalk between the patient ID and the medical record number or patient name and Date of Birth (DOB)  
- Medical groups or clinics that do not have an EHR should also maintain a crosswalk between patient ID and patient name and DOB as a tool to locate records during audit.  
**Data Portal Note:** A blank field will create an ERROR upon submission. **Quality Check:** Verify that there are not any duplicate patients. If a patient has multiple records (rows), determine which clinic the patient should be attributed to and delete the duplicate record(s). If submitting a sample population, you will need to replace the deleted record with the next patient listed in the random sample. | Text | 1 |
<table>
<thead>
<tr>
<th>Column</th>
<th>Field Name</th>
<th>Notes</th>
<th>Excel Format</th>
<th>Example</th>
</tr>
</thead>
</table>
| C      | Patient Date of Birth | Enter the patient’s date of birth.  
- The date of birth range for this age group is between 01/01/2001 to 01/01/2006.  
**Data Portal Note:** A blank field or a value outside of the allowable range will create an ERROR upon submission.  
**Quality Check:** Verify that each date of birth is within the accepted range. | Date (mm/dd/yyyy) | 10/13/2003 |
| D      | Patient Sex | Enter the patient’s sex:  
- F = Female  
- M = Male  
- U = Unknown/Undefined  
**Data Portal Note:** A blank field will create an ERROR upon submission.  
**Quality Check:** Verify that each cell has one of the accepted codes. | Text | F |
| E      | Zip Code_Primary Residence | Enter the five-digit zip code of the patient’s primary residence at the most recent encounter on or prior to 12/31/2018.  
- If extraction results in a nine-digit zip code, all nine-digits may be submitted. The MNCM Data Portal will only store the first five digits.  
**Data Portal Note:** A blank field will create an ERROR upon submission.  
**Quality Check:** Verify that the zip code is at least five digits and that each cell has a value. | Text | 55111 |
| F      | Race/Ethnicity1 | Please refer to a separate document entitled [REL Data Elements, Field Specifications & Codes](https://data.mncm.org/login) for Column F-N field definitions and specifications. This document can be found in the MNCM Data Portal under the Resources tab in the Race/Ethnicity/Language Data (REL) section, or on [MNCM.org](https://data.mncm.org/login) under Submitting Data > Training and Guidance > Data Collection Guides > Supplemental Specifications. | Number | 1 |
| G      | Race/Ethnicity2 | | |
| H      | Race/Ethnicity3 | | |
| I      | Race/Ethnicity4 | | |
| J      | Race/Ethnicity5 | | |
| K      | Country of Origin Code | | Number | 2 |
| L      | Country of Origin Other Description | For more information about collecting this data from patients, refer to the [Handbook on the Collection of Race Ethnicity and Language Data](https://data.mncm.org/login) available on [MNCM.org](https://data.mncm.org/login) under Submitting Data > Training & Guidance > Data Collection. | Text | CountryA |
### 2019 Adolescent Mental Health and/or Depression Screening Data Collection

<table>
<thead>
<tr>
<th>Column</th>
<th>Field Name</th>
<th>Notes</th>
<th>Excel Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>M</td>
<td>Preferred Language Code</td>
<td>Guides &gt; Supplemental Specifications.</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>N</td>
<td>Preferred Language Other Description</td>
<td>Quality Check: Verify that each cell has an accepted code. Blank cells (if data is not available) are acceptable.</td>
<td>Text</td>
<td>LanguageB</td>
</tr>
<tr>
<td>O</td>
<td>Provider NPI</td>
<td>Enter the 10-digit National Provider Identifier (NPI) of the provider to which the patient is attributed based on the attribution methodology detailed in Section II. If the provider does not have an NPI, enter the provider ID as registered in the MNCM Data Portal. <strong>Data Portal Note:</strong> A blank field will create an ERROR upon submission. <strong>Quality Check:</strong> Verify that each cell has data.</td>
<td>Text</td>
<td>1234567891</td>
</tr>
</tbody>
</table>
| P      | Provider Specialty Code          | Enter the specialty code of the physician. If the provider is not a physician, enter the specialty code of the supervising physician.  
1 = Family Medicine  
2 = Internal Medicine  
24 = Pediatric/Adolescent Medicine **Data Portal Note:** A blank field will create ERRORs upon submission. **Quality Check:** Verify that each cell has an accepted code. | Number       | 1           |
| Q      | Insurance Coverage Code          | Please refer to a separate document entitled Insurance Coverage Data Elements, Field Specifications & Codes for these field specifications. This document can be found via the link above, in the MNCM Data Portal under the Resources tab in the Insurance Coverage Field Specs & Codes for DDS section, or on MNCM.org under Submitting Data > Training and Guidance > Data | Number       | 1           |
| R      | Insurance Coverage Other Description |                                                                          | Text         | WORKERS COMPENSATION ONLY |

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2018. All rights reserved.
<table>
<thead>
<tr>
<th>Column</th>
<th>Field Name</th>
<th>Notes</th>
<th>Excel Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Insurance Plan Member ID</td>
<td>Collection Guides &gt; Supplemental Specifications.</td>
<td>Text</td>
<td>FBOXZ7969</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enter codes corresponding to the patient’s most recent insurance on or prior to 12/31/2018.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Quality Check:</strong> Verify that each cell has an accepted code and that all 99 codes have a name entered in Column R. Verify that Social Security Numbers are NOT submitted.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>Well-Child Visit Date</td>
<td><strong>Enter the date of the most recent well-child visit during the measurement period.</strong></td>
<td>Date (mm/dd/yyyy)</td>
<td>10/30/2018</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Data Portal Note:</strong> A blank field will create an ERROR upon submission.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Quality Check:</strong> Verify that the date is during the measurement period.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>U</td>
<td>Mental Health or Depression Screening Date</td>
<td><strong>Enter the date that the patient received a mental health and/or depression screening during the measurement period.</strong></td>
<td>Date (mm/dd/yyyy)</td>
<td>10/30/2018</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the patient received more than one screening during the measurement period, submit the date of the most recent screening.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Leave BLANK if the patient did not have a mental health and/or depression screening with one of the acceptable tools detailed in Column V.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Quality Check:</strong> Verify that the date is during the measurement period.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column</td>
<td>Field Name</td>
<td>Notes</td>
<td>Excel Format</td>
<td>Example</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
<td>---------</td>
</tr>
</tbody>
</table>
| V      | Mental Health or Depression Screening Tool    | Indicate which mental health and/or depression screening tool was administered.  
1 = Patient Health Questionnaire - 9 item version (PHQ-9)  
2 = PHQ-9M Modified for Teens and Adolescents  
3 = Kutcher Depression Scale (KADS)  
4 = Beck Depression Inventory II (BDI-II)  
5 = Beck Depression Inventory Fast Screen (BDI-FS)  
6 = Child Depression Inventory (CDI)  
7 = Child Depression Inventory II (CDI-2)  
8 = Patient Health Questionnaire - 2 item version (PHQ-2)  
9 = Pediatric Symptom Checklist - 17 item version (PSC-17) - parent version  
10 = Pediatric Symptom Checklist - 35 item version (PSC-35) - parent version  
11 = Pediatric Symptom Checklist - 35 item Youth Self Report (PSC Y-SR)  
12 = Global Appraisal of Individual Needs screens for mental health and substance abuse (GAIN-SS)  
- If the patient received more than one screening during the measurement period, submit the most recent tool that corresponds to the date in Column U.  
- See Appendix C for a comprehensive description of validated tools.  
- Leave BLANK if the patient did not have a mental health and/or depression screening with one of the above listed tools.  
**Quality Check:** Verify that each cell has an accepted code. | Number       | 8        |
| W      | Result of Tool                                | Enter the total score (result) from the mental health and/or depression screening tool administered.  
If the patient received more than one screening during the measurement period, submit the result of the most recent tool that corresponds to the values in Columns U and V.  
**Data Portal Note:** If Column V has an accepted code, then a blank field will create an ERROR upon submission.  
**Quality Check:** Verify that the result is within the valid range for the tool that is identified in Column V. | Number       | 15       |
C. Data Quality Checks

MNCM recommends that medical groups complete several quality checks of the data prior to file upload. Quality checks improve data accuracy, reduce the likelihood of errors, and ensure that the data can be successfully validated upon audit.

Quality Check 1: File Check

Use Excel’s AutoFilter feature to complete data quality checks of specific data elements in the Excel file.

To set the filter and review specific data elements:

1. Click inside any data cell and activate the AutoFilter by:
   a. In Excel 2003, click the Data menu, point to Filter, and then click AutoFilter.
   b. In more recent versions of Excel click the Data tab and in the Sort & Filter area click Filter.
2. Click on the drop-down boxes of any column and scan for key entry errors, “out-of-range” or missing data and determine if the data needs to be corrected.

Quality Check 2: Verify Clinical Data

Verify the collected clinical data by reviewing a small sample of records (eight to 10) to compare with the documentation within the patients’ medical records. If errors are identified, make the corrections in the data file. Also consider whether the errors were isolated or indicative of a larger data collection problem.

Quality Check 3: General

Complete the general quality checks outlined below:

1. Complete the quality checks listed in the Notes section of each data element in the Data Elements and Field Specifications table.
2. Verify that excluded records were removed.
3. Verify that all fields intended to be left blank are indeed blank. Do NOT enter hyphens or zeroes.
4. Remove blank rows at the bottom of the Excel spreadsheet.
   a. Press Ctrl/End to go to the bottom-most cell in the spreadsheet. If there are blank rows, highlight them, right-click in the left margin, and select Delete.
Section III: Data Submission

A. Data File Creation

Before proceeding with the file submission, be sure to:

- Complete all data collection and data entry.
- Complete data quality checks.
- Combine all clinic files onto one spreadsheet. All clinics in a medical group must be uploaded in one, single file. The clinic identifier is the Clinic ID.
- Verify that each column is formatted according to measure specifications (TEXT, NUMBER, or DATE formatting). Columns can be any width.
- Verify that all original columns remain in the spreadsheet even if there is no data in a column. Do NOT delete any columns.

Once the above steps are completed:
1. Save the Excel template.
2. Save the file in CSV format.
   a. The CSV file will be the data file uploaded to the MNCM Data Portal.

How to create a CSV file from an Excel file:

<table>
<thead>
<tr>
<th>For Excel 2003 Users</th>
<th>For Excel 2007 Users</th>
<th>For Users of more recent versions of Excel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the original Excel file (.xls).</td>
<td>3. Click the Office Button (upper left-hand corner of screen); select Save As.</td>
<td>3. Click the File tab (upper left-hand corner of screen); select Save As.</td>
</tr>
<tr>
<td>2. Activate the worksheet to be uploaded by clicking the worksheet tab.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Click File, Save As.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Navigate to the folder where the file will be saved.</td>
<td>5. Enter the file name.</td>
<td>6. At the bottom of the Save As dialog box, choose CSV (comma delimited) from the Save as type drop-down.</td>
</tr>
<tr>
<td>6. At the bottom of the Save As dialog box, choose CSV (comma delimited) from the Save as type drop-down.</td>
<td>7. Click Save. The following warning will appear: “...may contain features that are not compatible with CSV. Do you want to keep the workbook in this format?” Click Yes.</td>
<td></td>
</tr>
<tr>
<td>8. Close the file. A message will appear: “Do you want to save this file...?” Click Yes or No.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

NOTE: If corrections to the data are needed after the CSV file has been created; do NOT open the CSV file in Excel to make these corrections. Doing so alters the data. To make changes, follow these steps:
1. Open the original Excel template.
3. Save the Excel template.
4. Save the file with the changes as a new CSV file.
B. Data Submission

Data Submission
Click on **Data Submission** on the Home tab in the MNCM Data Portal under the Adolescent Mental Health and/or Depression Screening section. Use the following steps to submit data to MNCM.

**Step 1: Enter Denominator**
Using the instructions below, manually enter denominator counts and information or complete and upload a file with this information. Whether done manually or via a file upload, the information must be completed for each clinic row.

*For file upload, begin by clicking **Download the Denominator Worksheet**. Then follow the steps in the table below to complete the worksheet.*

**Denominator Entry Field Specifications**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Denominator Worksheet</th>
<th>Manual Entry</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method Used for Data Collection</td>
<td><strong>Column C</strong></td>
<td>Make selection applicable to the clinic from drop-down menu:</td>
<td>Best practice methods include:</td>
</tr>
<tr>
<td></td>
<td>Enter the code applicable to the clinic:</td>
<td></td>
<td>• Race: Self-Report: Allowing patient to self-report their race and/or Hispanic ethnicity</td>
</tr>
<tr>
<td></td>
<td>1 = EMR: All data pulled via query</td>
<td>• Race: Reporting Multiple Races: NOT using a multi-racial category, allowing patients to select more than one race AND using a system that allows the collection and reporting of more than one race for each patient</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 = EMR: Some data looked up manually</td>
<td></td>
<td>• EMR: All data pulled via query</td>
</tr>
<tr>
<td></td>
<td>5 = EMR: All data looked up manually</td>
<td></td>
<td>• Manual: Paper records only</td>
</tr>
<tr>
<td></td>
<td><strong>Columns D - G</strong></td>
<td>Check the box under each category for which best practices were utilized in the collection of REL data at the clinic.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enter the appropriate code for each category:</td>
<td></td>
<td>• Manual: EMR and paper record</td>
</tr>
<tr>
<td></td>
<td>1 = Yes, this clinic utilizes best practice</td>
<td></td>
<td>• EMR: Some data looked up manually</td>
</tr>
<tr>
<td></td>
<td>0 = No, this clinic does not utilize best practice</td>
<td></td>
<td>• EMR: All data looked up manually</td>
</tr>
</tbody>
</table>
# 2019 Adolescent Mental Health and/or Depression Screening Data Submission

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Denominator Worksheet</th>
<th>Manual Entry</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number of Patients that Meet Inclusion Criteria (Less Exclusions)</strong></td>
<td>Column H</td>
<td>Enter number of patients attributed to the clinic who are eligible or who met the inclusion criteria for the measure.</td>
<td>• Do NOT include patients who met an accepted exclusion&lt;br&gt;• If submitting a sample, the number of eligible patients must be higher than the Number of Patients Submitting</td>
</tr>
<tr>
<td><strong>Number of Patients Submitting</strong></td>
<td>Column I</td>
<td>Enter the number of patients attributed to the clinic who are being submitted</td>
<td>• Number(s) entered must match the count of patients in the data file&lt;br&gt;○ For total population submission, this count must match the Number of Patients that Meet Inclusion Criteria (Less Exclusions)&lt;br&gt;○ For a sample submission, this count must be less than the Number of Patients that Meet Inclusion Criteria (Less Exclusions)</td>
</tr>
<tr>
<td><strong>Not Reporting</strong></td>
<td>Columns J &amp; K</td>
<td>Check this box if the clinic is not reporting any data for this cycle of data collection. Enter a reason for not reporting in text box provided (e.g. no patients meet eligibility criteria).</td>
<td>• Please be advised that MNCM’s policy requires ALL clinic sites within a medical group to submit their data through the DDS process. Likewise, this is a condition of participation in pay-for-performance programs.</td>
</tr>
</tbody>
</table>

If completing the **Enter Denominator** step via file upload, save the completed file in CSV format (see Section III - A for more information). Click **Browse** or **Choose File** to locate the file and then click **Submit File**.

Once the information is populated either manually or via file upload, click **Save and Continue**.
2019 Adolescent Mental Health and/or Depression Screening Data Submission

**Step 2: Review & Save**
Verify the numbers entered by reviewing all of the clinic site’s information for accuracy (no typos or duplicate patients). Click **Save and Continue** or click **Back to Step 1** to correct the information.

**Step 3: Upload Data**
Click **Browse** or **Choose File** to search for the CSV file (Figure 1-A) and click **Upload CSV and Continue** (Figure 1-B).

**Home > Data Submission**

**Step 3: Upload Data**

The MNCM Data Portal will scan the CSV file to identify possible errors. The Data Portal will then provide an upload status that will indicate if there are errors or warnings in the data file. Click on the **Refresh** link to view an updated upload status (Figure 2).

**Home > Data Submission**

To view errors and warnings, click **View Errors & Warnings** (Figure 3-A).

- **Errors**: Corrections must be made, and a corrected file uploaded (e.g., date of birth is out-of-range). Refer to the Data Elements and Field Specifications to review the required data specifications for each column.
  - **Make corrections in the original Excel file and save the corrected file**. Then save as a new CSV file to upload. Do NOT make corrections in the CSV file as this will alter the data.

Helpline: 612-746-4522 | E-mail: **support@mncm.org** | MNCM Data Portal: **https://data.mncm.org/login**

© MN Community Measurement, 2018. All rights reserved.
2019 Adolescent Mental Health and/or Depression Screening Data Submission

- To re-enter the data collection method and/or REL Best Practice status and upload the corrected file starting from Step 1: Enter Denominator click Clear & Start Over (Figure 3-B).
  - Completion of Steps 1, 2 and 3 will be necessary if Clear & Start Over is clicked.
- If corrections are only needed to the data file, click Re-Upload Data (csv) file (Figure 3-C). Begin with Step 3: Upload Data.

  - **Warnings:** Closely review these possible errors and decide whether corrections are needed. If corrections to the data file are necessary, refer to instructions above. If corrections are not necessary, click Continue to Step 4 (Figure 3-D).

Once the Data (CSV) File has been successfully uploaded to the Data Portal, click Continue to Step 4 (Figure 3-D).

---

### Step 4: Review & Submit

1. Review the quality checks for each item listed in the Data Elements and Field Specifications table as well as the preliminary results and their comparison to the previous measure period’s results to determine if there are errors in the data.
   - To resubmit the data file only, click Re-Upload Data (CSV) File.
   - To resubmit the denominator counts and the data file, click Clear & Start Over at the bottom of the page.

   **Again, make corrections in the original Excel file and save the corrected file with a new name.** Then save as a new CSV file to upload. Do NOT make corrections in the CSV file as this will alter the data.

2. Complete the Data Comparison Notes. **This is a required field.**
   **NOTE:** If this is the first data submission for this measure or if there have been substantial changes to the measure itself, there will be no table showing comparison of population and rates to a previous submission and the Data Comparison Notes text box will not display.

   **Review and compare** the group and individual clinic results (population and rates) to the prior submission:
   - **Number of Patients That Meet Inclusion Criteria (Less Exclusions)** – This column contains the number of patients in the eligible population for the current and previous submission.

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login

© MN Community Measurement, 2018. All rights reserved.
• **Rates** – These columns contain rate results for the current and previous submission.

Using the text box provided, *describe reasons for any substantial changes* in population or results from the previous submission. Comments in this field inform MN Community Measurement about reasons for the changes and avoids additional follow-up. After you complete the text box, click **Save Notes**.

• To complete this step later, click **Save as Draft**. To access the submission again, click on **Data Submission** under the Adolescent Mental Health and/or Depression Screening section on the Home tab. Contact support@mncm.org if you need assistance.

3. **When the data is ready to submit to MN Community Measurement** click **Submit Data to MN Community Measurement**.
   • The **Submit Data to MN Community Measurement** button will not appear until the Data Comparison Notes step has been completed as stated above.

**Step 5: Done**

The data file has been successfully submitted. The MN Community Measurement Data Portal will generate an e-mail confirming receipt.

To download a report of patient level numerator compliance information, click **Download Data** near the top of the data comparison section. Columns on the far right of the report indicate which patients were included in the numerator (1) and which were not (0).
Section IV: Data Validation

After data is submitted, MNCM completes the following validation of the preliminary results to ensure accuracy and comparability.

Quality Checks
MNCM completes quality checks of the submitted data. If errors are identified, the medical group must make corrections to the data file and resubmit.

Validation Audit
All medical groups are subject to an audit. Medical groups selected for an audit are contacted by MNCM. A list of records for audit will be provided and posted onto the Home page of the Data Portal for the medical group. Other audit preparations:

- The medical group or clinic site representative must be available to participate in the entire audit process.
  - For data that resides in an electronic record, the audit will be conducted via a HIPAA secure, online meeting service; the medical group or clinic representative will need to retrieve and display the selected records and screens necessary to complete the audit.
  - For data that resides in a paper record, the audit will take place onsite.
- Patient names or other personal information may be blinded. MNCM will verify date of birth.
- The following items must be available for the audit:
  - All requested patient records.
  - The “crosswalk” between the unique patient identifier and the patient’s name and date of birth, as necessary.
  - Data collection forms and other notes describing where various data elements were located in the patient record.
  - List of patients that were excluded.

NCQA 8 and 30 Audit Process
MNCM utilizes the National Committee for Quality Assurance (NCQA) “8 and 30” process for audits.

- MNCM randomly selects 33 records from each applicable clinic site for validation. At most, 30 records for each clinic site will be reviewed. The additional three records are oversamples to ensure 30 records will be available on the day of the review.
- The MNCM auditor reviews records one through eight in the sample to verify whether the submitted data matches the source data in the medical record.
- If no errors are found in these eight records, the compliance rate is 100 percent, and the clinic site is determined to be in high compliance. The MNCM auditor may determine no further record review is necessary. The MNCM auditor communicates results to MNCM staff.
- If the auditor identifies one or more errors in these eight records, the auditor will continue auditing records nine through 30 and a compliance rate is calculated (e.g., 27/30 records compliant, 90 percent). If the compliance rate is less than 90 percent, the auditor will communicate the results with MNCM, who will contact the medical group to discuss a corrective action.
Two-Week Medical Group Review of the Preliminary Statewide Results
The two-week medical group review is the medical group’s official opportunity to review and comment on the preliminary statewide results. MNCM will provide a file of the results to all participating medical groups. Each medical group is responsible for reviewing their own results, investigating any concerns, and submitting evidence to MNCM if a change in results is requested. MNCM staff will review all requests and determine an appropriate course of action. A notification about this review will be sent to the primary data contact and other key contacts registered by the medical group in the MNCM Data Portal.

After Validation
After MNCM validation is completed, MNCM will approve the data in the MNCM Data Portal. An e-mail will be sent to the medical group’s data contact notifying them that the data was approved.

After all statewide results are approved, MNCM may publish clinic and medical group level results on MNHealthScores.org. Results can also be found on the MNCM Data Portal > Results tab.

Medical groups should maintain data submission files and other documents related to data submission for two years.
Appendices

Appendix A: About Direct Data Submission

The goal of Direct Data Submission (DDS) is to collect patient-level data from medical groups on specific health care conditions and publicly report comparable results of health care quality at the clinic site level. All medical groups follow the same instructions for eligible population identification and data collection. MNCM certifies methodologies prior to data collection. Then each medical group submits data to MNCM via a secure, online data portal. As an independent auditor and as a service to each medical group, MNCM validates the data for accuracy, calculates results from the validated data, and publicly reports the data on MNHealthScores.org.

Required Reporting

DDS fulfills participation requirements for the Minnesota Department of Health’s Minnesota Statewide Quality Reporting and Measurement System (SQRMS) as well as other health plan pay-for-performance programs. In addition, DDS results can be used by medical groups for quality improvement purposes.

DDS Terms and Conditions

To participate in the DDS process, medical groups must agree to:

- MNCM’s DDS Terms and Conditions (signed electronically on the MNCM Data Portal).
- Complete a Business Associate Agreement with MNCM (signed electronically on the MNCM Data Portal).
- Submit a patient-level file to the secure MNCM Data Portal that automatically calculates results.
- Participate in the data validation process as required by MNCM.
- Have results publicly reported on MNHealthScores.org and in other reports.
- Submit data for ALL clinic sites.
- Submit data in required format (CSV).
- Submit data in good faith.
- Adhere to and follow all data submission timelines and formatting specifications.

Medical groups also understand that:

- MNCM works with corresponding health plans to determine Primary payer type (Commercial/Private, Medicaid, Medicare, uninsured/self/pay) on your behalf to reduce burden.
- Most Minnesota health plans only accept results generated from the DDS method for their incentive programs, because the patient-level results can be validated.
Compliance with Federal and State Regulations

Our legal counsel has assured us that the DDS method complies with applicable provisions of the Health Insurance Portability and Accountability Act (HIPAA), Health Information Technology for Economic and Clinical Health (HITECH) Act, and Minnesota statute as long as we are acting as a business associate to each participating medical group (e.g., by gathering and submitting data on its behalf) and have a signed BAA with the medical group. The BAA is signed electronically on the MNCM Data Portal. The BAA is signed once and remains in effect for all DDS measures.

Health Insurance Portability and Accountability Act Law:

- The activities of data collection, data submission, public reporting and use of results for quality improvement are considered within the scope of health care operations associated with the medical group quality improvement efforts.
- The federal HIPAA law specifically allows release of individually identifiable health information - without the consent or authorization of the individual - for treatment, payment and health care operations of, or for, the provider.
- MNCM’s business associate agreement includes all provisions required by the HITECH Act.

Minnesota Statute:

- The primary governing Minnesota statute is MN Stat. Section 144.335.
- Subd. 3a. entitled “Patient consent to release of records; liability” states: (a) A provider, or a person who receives health records from a provider, may not release a patient’s health records to a person without a signed and dated consent from the patient or the patient’s legally authorized representative authorizing the release, unless the release is specifically authorized by law.
- However, the statute does not restrict release (without patient authorization) to only those circumstances authorized by state law – the statute also applies to a release authorized by federal law.
- Legal counsel assures us that it is reasonable to conclude that the HIPAA privacy regulation does specifically authorize the release of such information. A covered entity is authorized by HIPAA to release patient information for, among other things, health care operations and to its business associate that is providing such health care operations on its behalf. As stated above, the services MNCM is engaged in with providers falls within the scope of health care operations, and MNCM is acting as a business associate to the medical groups when performing the services discussed above.
Appendix B: Sampling Methods

Prior to pulling a random sample of patients, all patients who meet eligibility criteria must first be identified. Please see Section II for more detailed information about identifying all patients who meet eligibility criteria. After identifying the eligible population, use Method 1 or 2 to pull a random sample of patients from the eligible population for each clinic. The patients pulled into the random sample will be the patients who will be included in the data submission file.

Method 1: Excel Random Number Generator
1. Insert a blank column on the leftmost side of the spreadsheet.
2. Label new column RAND.
3. Place cursor in the first blank cell (A2) and type =RAND().
4. Press enter (a number like 0.793958 will appear).
5. Place the cursor back into this cell; resting over the corner to have the pointer change to a black cross, double click or drag the formula down to the last row/patient.
6. Highlight the whole column and click Edit, Copy, Paste Special = Values to freeze the random number (otherwise it will change with every click on the spreadsheet).
7. Sort entire eligible population by this new random number.
8. Work down the list row by row, starting with the first row until the number of records in the sample is met for submission (at least 60 patients per clinic, plus at least 20 oversamples = 80 patients per clinic).
9. If a patient meets one of the required exclusions, do not include the patient in the data submission. Note the exclusion reason on the data collection form and keep working down the list. Use oversample records following the last record/row of the original sample. For example, if 60 records are being submitted and two exclusions were found in the first 60 records/rows, use the patients from rows 61 and 62 to replace the excluded records/rows.

Method 2: Systematic (Nth Method) Sample Selection
1. Start with a list that has patients sorted by some unique patient related variable.
   a. An identifying number like a medical record number or chart number is ideal.
   b. Sorting alphabetically is the least desirable in terms of randomness; however, this may be used when there is no other alternative.
2. Select every Nth patient for the number of patients that will be reported. N should equal the clinic site’s total eligible population divided by the number of patients that will be submitted (if needed, round down to the nearest whole number). Highlight or mark every Nth patient on the list. This is the sample.
   a. Example: If a clinic site has 600 eligible patients and 60 patients will be submitted, divide 600/60 = 10. Select every 10th patient on the list.
3. If a patient meets one of the accepted exclusions, do not include the patient in the data submission. Note the exclusion reason on the data collection form and select the next patient on the list (just below the excluded patient).
   a. Example: If every 10th patient on the list was selected, and the 1st patient in the sample (the patient on row 10) has an accepted exclusion reason, select the patient on row 11
to replace the patient that was excluded. Then proceed to the next patient selected for the sample (patient on row 20).

**Missing records:** If a record in the sample is not available or missing, do NOT exclude this record. Locate the record or, if the record cannot be located, include the record and leave the data fields blank.
## Appendix C: Mental Health/Depression Instruments and Descriptions

Tables courtesy of staff at the Minnesota Department of Health and Department of Human Services

<table>
<thead>
<tr>
<th>TOOL</th>
<th>SCREENING PURPOSE</th>
<th>AGE</th>
<th>DESCRIPTION</th>
<th>LINGUISTIC/CULT SENSITIVITY</th>
<th>PSYCHOMETRICS</th>
<th>PRACTICALITY</th>
<th>COST/ AVAILABILITY</th>
</tr>
</thead>
</table>
| **PHQ-9**             | Depression and suicide risk | 13 years to adult | 9 items, self-reported by patient | Available in multiple languages | **Reliability:** No data found.  
**Validity:** Area under ROC curve .88.  
**Sensitivity:** .895  
**Specificity:** .775 (cut-off score of >11) | Administration is less than 5 mins.  
Minimum expertise necessary is not specified. | Free.  
[www.phqscreeners.com](http://www.phqscreeners.com) |
| **PHQ-9, Modified for Teens** | Depression and suicide risk  
Text slightly modified from PHQ-9. | 12-18 years | 9 items, self-reported by patient | Validated in English.  
Available in Spanish.  
Norms not available. | **Reliability:** No data found.  
**Validity:** No data found.  
**Sensitivity:** .73  
**Specificity:** .94 | Administration is less than 5 mins.  
Minimum expertise necessary is professional or office staff. | Free.  
Available in multiple places online.  
| **KADS**  
Kutcher Adolescent Depression Scale | Depression | 12-17 years | Versions:  
16 items  
11 items  
6 items | 6 item and 11 item versions are available in multiple languages.  
Text is in 6th grade reading level. | **6 Item Version:**  
**Reliability:** Internal consistency .90  
**Specificity:** .71 based on cut-off score 6 (6 items)  
**11 Item Version:**  
**Reliability:** Internal consistency .84  
16 Item Version:  
**Reliability:** Internal consistency .84  
All Versions:  
**Validity:** Area under (ROC) curve .89  
**Sensitivity:** .92 | Administration is 5 mins and scoring is 1 min.  
Minimum expertise necessary is Trained health care professionals or educators. | Free with permission.  
[www.teenmentalhealth.org](http://www.teenmentalhealth.org) |
<table>
<thead>
<tr>
<th>TOOL</th>
<th>SCREENING PURPOSE</th>
<th>AGE</th>
<th>DESCRIPTION</th>
<th>PSYCHOMETRICS</th>
<th>PRACTICALITY</th>
<th>COST/ AVAILABILITY</th>
</tr>
</thead>
</table>
| BDI II Beck Depression Inventory II | Depression and suicide risk Reflects DSM IV criteria. | 13 years to adult | 21 items, self-reported by patient                                            | Reliability: Internal consistency: .92  
Validity: Convergent .84; Area under ROC curve: .78  
Sensitivity: .84  
Specificity: .81 | Administration is 5 mins.  
Minimum expertise necessary is Master’s level or higher. | Proprietary. $121.50/kit*, including manual & 25 record forms. www.pearsonassessments.com |
| BDI-FS BDI – Fast Screen | Depression                                                                     | 13 years to adult | 7 items, self-reported by patient                                            | Reliability: Internal consistency .89  
Validity: Area under ROC curve: .90  
Sensitivity: .89  
Specificity: .74 (cut-off score 6) | Administration is less than 5 mins.  
Minimum expertise necessary is Master’s level or higher. | Proprietary. $100/kit* including manual & 50 record forms. www.pearsonassessments.com |
| CDI Children’s Depression Inventory Original Version | Depression  
Can be used in multiple settings including primary care. | 7-17 years | 27 items, self-reported by patient  
12 items, reported by teacher  
17 items, reported by parent | Reliability: English Internal consistency .83-.88; Spanish Internal consistency: .85 boys and .86 girls; Test-retest: .86  
Validity: Convergent: .56-.78  
Sensitivity: .94  
Specificity: .84 (cut-off score 16) | Administration is 15 mins.  
Minimum expertise necessary is trained professionals and paraprofessionals. | Proprietary. $330/kit*, including manual and 25 each of parent, teacher forms. Multi Health Systems www.mhs.com |
| CDI-2, Children’s Depression Inventory, 2nd version | Depression  
Has emotional and functional scales. | 7-17 years | 28 items, self-reported by patient  
OR 10 item, self-reported by patient  
12 items, reported by teacher.  
17 items, reported by parent. | Reliability: internal consistency .91 (28 item youth) (.82 (10 item youth)); subscale internal consistency .76-.85 (youth), .89 (teacher), .88 (parent). Test-retest .98 (youth).  
Validity: No data found  
Sensitivity: .83  
Specificity: .73 | Administration is 15-20 mins for the 28 item scale and 5 mins for the 10 item scale.  
Minimum expertise necessary is not specified. | Proprietary. $289 for complete kit*, including manual and 25 each of long forms, short forms, parent report, & teacher report. www.pearsonassessments.com |

* Price estimates for proprietary tools obtained during measure development in 2013 and may be subject to change.
### 2019 Adolescent Mental Health
and/or Depression Screening
Appendices

Table 3: Depression only screeners – Acceptable but Not Highly Recommended and Public Domain

<table>
<thead>
<tr>
<th>TOOL</th>
<th>SCREENING PURPOSE</th>
<th>AGE</th>
<th>DESCRIPTION</th>
<th>LINGUISTIC/CULT SENSITIVITY</th>
<th>PSYCHOMETRICS</th>
<th>PRACTICALITY</th>
<th>COST/ AVAILABILITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>PHQ-2 Patient Health Questionnaire – 2 item</td>
<td>Depression.</td>
<td>12-20 years</td>
<td>2 items, self-reported by patient First line screening measure</td>
<td>Available in many languages.</td>
<td>Reliability: Internal consistency: .84. Validity: cutoff ≥2 Sensitivity: .86-.92 Specificity: .70-.79</td>
<td>Administration 1 minute. Minimum expertise necessary is not specified. First-stage screener for 12 years and older; if PHQ-2 score is ≥2, screen at same visit with PHQ-9 or other validated depression screening tool</td>
<td>Free. First two items of the PHQ-9: <a href="http://www.phqscreeners.com">www.phqscreeners.com</a></td>
</tr>
</tbody>
</table>
# 2019 Adolescent Mental Health and/or Depression Screening Appendices

Table 4: General mental health screeners – Highly Recommended or Proprietary with Permission in MN

<table>
<thead>
<tr>
<th>TOOL</th>
<th>SCREENING PURPOSE</th>
<th>AGE</th>
<th>DESCRIPTION</th>
<th>LINGUISTIC SENSITIVITY</th>
<th>PSYCHOMETRICS</th>
<th>PRACTICALITY</th>
<th>COST/ AVAILABILITY</th>
</tr>
</thead>
</table>
| PSC-17 Pediatric Symptom Checklist, 17 item version (parent version) | Mental health screening and functional screening. | 4-16 years | 17 items reported by parent  
There is a 17 item youth self-reported by patients 11 years and older; but this tool's score is not validated and therefore cannot be recommended for use | Parent tool is available in English, Spanish, Chinese, and Vietnamese. Youth tool is available in English and Spanish.  
Text is in 5th-6th grade reading level. | **Parent version**  
Reliability: Internal consistency .67-.82  
Validity: Concurrent .72-.74  
Sensitivity: .42-.88  
Specificity: .61-.91  
Youth version  
No data available. Do not use the youth version. | Administration is less than 5 mins and scoring is 1-2 mins.  
Minimum expertise is not specified for admin/scoring. Master degree recommended for interpretation. | Free  
www.massgeneral.org/psychiatry/services/psc_home.aspx |
| PSC-35 (parent version)     | Mental health screening and functional screening. | 4-16 years | 35 items reported by parent  
35 items reported by patients 11 years and older  
Either the parent version or the Youth Self-Report version can be used. | Validated in U.S., Japan, Austria, Chile, Philippines, and Botswana.  
Written versions available in multiple languages. Audio versions available in English, Hmong, Somali and Spanish. | **Reliability:** Internal consistency .91 (parent); Test-retest .84-.91  
**Validity:** Validated per publisher  
**Sensitivity:** .68  
**Specificity:** .95 (Parent version, cut-off score 28) | Time to administer is 5 mins and scoring is 1-2 mins.  
Minimum expertise is not specified for admin/scoring. Master degree recommended for interpretation. | Free  
http://www.massgeneral.org/psychiatry/services/psc_forms.aspx |
| PSC-35 YSR Youth Self-Report Pediatric Symptom Checklist | Mental health screening and functional screening. | 4-16 years | 35 items reported by parent  
35 items reported by patients 11 years and older  
Either the parent version or the Youth Self-Report version can be used. | Validated in U.S., Japan, Austria, Chile, Philippines, and Botswana.  
Written versions available in multiple languages. Audio versions available in English, Hmong, Somali and Spanish. | **Reliability:** Internal consistency .91 (parent); Test-retest .84-.91  
**Validity:** Validated per publisher  
**Sensitivity:** .68  
**Specificity:** .95 (Parent version, cut-off score 28) | Time to administer is 5 mins and scoring is 1-2 mins.  
Minimum expertise is not specified for admin/scoring. Master degree recommended for interpretation. | Free  
http://www.massgeneral.org/psychiatry/services/psc_forms.aspx |
| GAIN-SS Global Appraisal of Individual Needs, Short Screener | Mental health disorders, substance use, crime/violence. | 12 years to adult | 20 items, self-reported by patient | Available in English.  
“Spanish & other language versions will be made available via website as they are released.” | **Reliability:** Internal consistency .96  
**Validity:** Correlation .84-.94 with full 123-item GAIN  
**Sensitivity:** .90  
**Specificity:** .92 | Time to administer is 10 mins.  
Minimum expertise necessary is minimal. | Proprietary; Minnesota has license for all MHCP providers. |
Appendix D: Glossary of Terms

Standard list of terms often used in the data submission process. Not all terms apply to all measures.

Allowable Exclusions: Allowable exclusions are optional. A medical group may choose to remove patients from data submission who meet the criteria described in the Allowable Exclusions section of the measure specifications.

Assignment: The process by which clinics are assigned to clinical quality measures, for which they are then responsible to report data to MNCM. Assignments are based on specialties offered at each clinic. These specialties are selected by the medical group during clinic registration.

Audit: The process by which MNCM reviews and validates the data submitted to ensure the data reflects the patient record. Audits are completed on-site at a clinic or electronically.

Calculated Exclusions: Exclusions that are calculated by the MNCM Data Portal based on data supplied in the data file. Patients to whom a calculated exclusion applies must still be included in the data file; upon submission, the Data Portal will remove the appropriate patients from measure calculation.

Clinic: The individual practice site or sites that are registered under the main medical group. Clinics are locations where primary or specialty care ambulatory services are provided for a fee by one or more physicians.

A clinic site location is a building, separate space or an entity with a street address. It should be a functional unit that is easily understood by patients/consumers. The goal of reporting by clinic site is to provide patients/consumers with information about the entity with which they are most familiar and to provide information to clinics that is actionable for quality improvement purposes.

Clinic and Provider Registration: The annual process by which clinics and providers register on the MNCM Data Portal. Providers who worked at a clinic site during the previous calendar year must be registered. Typically this occurs annually during December and January. Please see the Clinic and Provider Registration Instructions for specific details and guidance.

Clinic ID: Assigned to a clinic by the MNCM Data Portal when the clinic first registers on the MNCM Data Portal.

Clinical Staff: Defined, for the purposes of Clinic and Provider Registration, as the following provider types: physicians (MD or DO), advanced practice registered nurses (e.g., Certified Nurse Practitioner, Certified Nurse Specialist, and Certified Nurse Midwife) and physician assistants (PA).

Contacts Tab: Tab in the MNCM Data Portal that lists all contacts for a particular medical group. Medical groups can add, remove or edit contact people on this tab. While changes can be made at any time, this information must be updated by medical groups during Clinic and Provider Registration.

Crosswalk: Process by which a unique identifier is linked to a patient’s name and date of birth so medical records can be located by clinic staff in the case of an audit by MNCM.
CSV File: Acronym for “comma separated values.” A CSV file is a common and simple format that is used to import/transport data between systems or software applications that are not directly related (e.g., from a spreadsheet to a database). All data submission files are formatted as CSV files.

Data Collection Form: Form that has all patient-level data elements necessary to collect for measure. It is optional for medical groups to use this form. It may be most useful for clinics/medical groups using paper records.

Data Collection Guides: Document providing instructions for clinics/medical groups to submit data counts or files to the MNCM Data Portal.

Data Comparison: Part of DDS process where clinics/medical groups are asked to review the current measurement period’s preliminary results for each clinic compared to the last data submission for this measure and consider any changes between the current period and the prior period. It is expected that an explanation will be entered into a text box to account for any changes or to indicate that the data comparison is expected.

Data Elements: Components necessary to submit data files to MNCM and to calculate measure results.

Data File: Excel template supplied on the MNCM Data Portal for DDS data submission. Templates are specific to and formatted correctly for each measure.

Data File Transfer Selection: MDH has requested the receipt of patient level data. Medical groups must indicate on the MNCM Data Portal if they chose to allow MNCM to share patient-level data with MDH. This is called Data File Transfer Selection. Detailed information about the Data File Transfer Selection options can be found in Section I of the data collection guides.

Data Portal: Secure, HIPAA-compliant portal owned by MNCM where clinics/medical groups can submit patient-level data to MNCM for validation and accurate calculation of results.

Data Quality Checks: MNCM recommends completing several internal quality checks of the data prior to data file submission. Quality checks improve data accuracy, reduce the likelihood of errors and ensure the data can be validated upon audit. Please refer to specific data collection guides for guidance on data quality checks for each measure.

Denominator: The denominator is the bottom number in a fraction. In epidemiology, it represents a population group at risk of a specific disease. In clinical quality measurement, it is the total number of patients (or observations) included in the calculated score.

Direct Data Submission (DDS): The DDS method was developed by MNCM to allow medical groups to submit patient-level data for verification of results. In this process, medical groups upload files of patient-level clinical data and clinic results are automatically calculated by the MNCM Data Portal. MNCM validates data submitted through the DDS process before results are publicly reported.

Electronic Medical Record: A digital version of a paper chart that contains all of a patient’s medical history from one practice, which is also known as EMR or Electronic Health Record (EHR).
**Eligible Population**: A group of patients who have met all eligibility criteria to be included in a measure.

**EMR Reporting Rule**: Established by MDH, clinics that had an EMR in place (at any stage) for the last two measurement periods are required to submit data on their total population.

**Errors**: The error and warning report will be displayed after a patient-level data file is submitted via the MNCM Data Portal. Errors are “hard stops” in the Data Portal (e.g., dates of birth in the file are outside the date of birth range specified for a measure) that result in the submission of a file not being allowed. They must be corrected and a revised patient level data file must be uploaded to the Data Portal before submission can occur.

**Excel Format**: Format of Excel template columns necessary to submit data file to MNCM Data Portal.

**Excel Template**: See Data File.

**Exclusions Template**: Template available on the MNCM Data Portal for tracking excluded patients. This document will need to be uploaded to the MNCM Data Portal when the clinical data file is submitted on measures for which exclusions are tracked. MNCM will review this list and validate a selection of records during the validation audit. Please read more about the Exclusions Template in Section III.

**Field Specifications**: The detailed section in the data collection guides that provides instructions and guidance for the collection of required data elements for measure score calculation.

**Final Results**: Results calculated by the MNCM Data Portal after submission of a patient level data file after validation is completed. Final results are displayed on MHealthScores.org.

**Full-Time Equivalent (FTE)**: The best reflection of the time the provider practiced in a typical work week at each clinic site over the course of a calendar year. FTE information is submitted during Clinic and Provider Registration in the provider registration step. Please see the Clinic and Provider Registration Instructions guide for more information.

**Group and Clinic Sites Tabs**: These tabs display information about the medical group and clinic sites in the MNCM Data Portal. Information can be edited for the group or clinic sites as needed.

**Home Tab**: This tab displays information about all the current measures and deadlines for which the medical group is responsible.

**Hospital-Based Outpatient Clinic Locations**: These are included in the physician clinic definition and must be registered and report required measures.

**Inactive Patients**: Patients designated as inactive in a practice management system, billing system or electronic medical record must be included in the eligible population if they meet measure criteria.

**Insurance Coverage Data Elements, Field Specifications and Codes**: Document to be used in conjunction with the data collection guides to accurately collect and report insurance coverage data elements.
Inter-Rater Reliability (IRR): Recommended to conduct several sample audits with all abstractors for training purposes if more than one person will abstract data. This ensures measurement specifications are interpreted consistently and data is collected uniformly.

Measure Logic/Flow Charts: Used to help illustrate the identification of the eligible population and the logic of measure calculation.

Measure Specifications: Provide detailed information about each measure, including measure description, methodology, measurement period, denominator, exclusions and numerator. Located in the data collection guides that are available on MNCM.org and the MDH website.

Medical Group: The highest level of the MN Community Measurement Data Portal clinic and provider registration construct. The medical group represents a single centralized organization that operates one or more clinic sites. Organizations define the parameters of the medical group at the time of registration and may choose to divide clinics operated by the organization into more than one medical group. Medical groups with only one clinic site must enter information under both the medical group and clinic sections, even though the information will be the same. When reporting on the clinical quality measures, data for all clinic sites is submitted to MN Community Measurement in one file via the medical group.

Medical Group ID: Assigned to a medical group by MN Community Measurement when the medical group first registers on the MN Community Measurement Data Portal.

Multi-Specialty Clinics: A clinic site that has multiple specialties located in one building (one street address). Medical groups have the option to register a single clinic site or register each specialty as its own clinic site and then also register a main clinic site. How clinics decide to register depends on how the clinic desires to have their clinical measures publicly reported on MNHealthScores.org. Please review the Clinic and Provider Registration Instructions guide for further information about registering multi-specialty clinics.

National Provider Identifier (NPI): A unique identifier for individual providers or organizations that render health care. Health care providers who are HIPAA-covered entities obtain an NPI to identify themselves in HIPAA standard transactions. Also referred to as Provider ID.

Newly Opened/Acquired Clinics: If a medical group opened or acquired a new clinic in the last year, the new clinic must be registered with the medical group and must submit data with the medical group. If the new clinic uses a different practice management system, billing system or EMR, they should follow the same instructions and measure specifications to collect the data, and the medical group should include the new clinic’s data in the data submission to MN Community Measurement.

Number of Eligible Patients (Exclusions Removed): Number of patients who are eligible or met the inclusion criteria for the measure with excluded patients removed for each clinic. This count should be entered into the MN Community Measurement Data Portal during data submission.

Number of Patients Submitting: Number of patients who are eligible and being submitted. This should be the same number as the as Number of Eligible Patients (Exclusions Removed) if submitting total.
population. If submitting a sample population, this is the number of patients in the sample population. This number must match the number of patients in the data file.

**Numerator:** The numerator is the top number in a fraction. In epidemiology, it represents the number of people in a population group who develop the disease of interest. In clinical quality measurement, it is the number of patients that meet all specified targets of a measure.

**Patient Attribution:** A patient is attributed to one clinic and provider that are considered to be responsible for managing the patient’s care. Please refer to specific data collection guides to review patient attribution for each measure as it they differ.

**Patient-Level Data:** Data elements required to calculate measure results. Data is submitted to MN Community Measurement (MNCM) Data Portal via a HIPAA-secure process.

**Patient Registries:** A tool used by some medical groups to track patient progress and for quality improvement purposes. MNCM cautions the use of patient registry information for quality measures. Many registries give a “snapshot” of patients at a given time and would therefore not include all patients according to established patient criteria or may not reflect the most recent clinical data (e.g., most recent blood pressure or labs). Registries that are programmed to update the patient population and clinical results on a continual basis (24/7) could possibly be used to create data file for submission; however, please discuss this with MNCM before use. During the validation audit, the MNCM auditor will use the patient record not the patient registry. If a clinic uses data from a patient registry, the auditor may find a more recent date/value in the medical record and this would be counted as an error.

**Pre-Submission Data Certification:** This process is intended to help identify potential data issues prior to file submission.

**Pre-Submission Data Certification Form:** Document medical groups complete to outline the method for identifying the eligible population and other details pertinent to the validation of submitted data.

**Preliminary Results:** Results calculated by the MNCM Data Portal after submission of a data file but before results are fully validated.

**Primary Data Contact:** The person from the medical group who uploads/submits data files for the clinical quality measures; receives communications from MNCM about data submission and other important updates; and completes the medical group’s annual registration of the clinics and clinical staff on the MNCM Data Portal. It is important that the Primary Data Contact information for medical groups remains up-to-date to ensure MNCM communication is received by the appropriate person in a timely manner.

**Provider File:** Excel Template available on the MNCM Data Portal for Clinic and Provider Registration. This document is uploaded to the MNCM Data Portal during registration.

**Provider ID:** Created by medical group/clinic for providers who do not have an NPI. This ID will be used in the data file submission to MNCM.
Provider Type: Medical Doctor (MD, including physicians who have medical degrees from other countries such as MBBCH, MBBS, MBCHB); Doctor of Osteopathy (DO); Physician Assistant (PA) or Advanced Practice Registered Nurse (e.g., Certified Nurse Practitioner, Certified Nurse Specialist, Certified Nurse Midwife) are providers that are required to be registered during Clinic and Provider Registration. Refer to the specific measure specifications for eligible provider types required to report clinical data for each measure as they differ.

Provider Registration: See Clinic and Provider Registration.

Provider Specialty Code: Codes generated by MNCM to indicate the board certified specialty of providers. The codes are included in the provider registration file and DDS data file. Please see the Clinic and Provider Registration Instructions guide as well as each data collection guide for further guidance.

Providers Tab: This tab displays all of the information about providers submitted during Clinic and Provider Registration.

REL: Acronym referring to data elements of race, Hispanic ethnicity, preferred language and country of origin.

REL Best Practice: Data collection best practice methods for REL data elements include: allowing patients to self-report race and Hispanic ethnicity, preferred language and country of origin as well as NOT using a multi-racial category; allowing patients to select more than one race; and using a system that allows the collection and reporting of more than one race for each patient. For more information about collecting this data from patients, refer to the Handbook on the Collection of Race Ethnicity and Language Data available on MNCM.org under Submitting Data > Training & Guidance > Data Collection Guides.

REL Data Elements, Field Specifications and Codes: Document to be used in conjunction with the data collection guides to accurately collect and report REL data elements.

Required Exclusions: This type of exclusion is required. A medical group must remove patients from data submission who meet the criteria described in the Required Exclusions section of the Measure Specifications. These exclusions have evidence that they are clinically appropriate or that the frequency and impact of the inclusion of these patients would distort the calculated result.

Results Tab: This tab includes final data results and file downloads from prior submission cycles, as well as charts of current and historical results.

Resources Tab: This tab is organized by topic or measure, and houses data submission guides, tools and frequently asked questions by measure.

Roll-up: Process by which multiple clinics report data under one clinic. Clinics can report clinic quality data as one clinic if they meet all of the three following criteria: A) have common ownership; B) have a majority (more than half) of common clinical staff working across the multiple locations (these clinical staff must rotate between all of the clinic locations); and C) the total clinical staff across all locations is no greater than 20 FTEs. Please see clinical staff for further details.

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2018. All rights reserved.
Sample Population: A random selection of patients to be submitted for clinical measures. The sample population is drawn from the total eligible population. The minimum required sample is 60 patients per clinic site. See the EMR Reporting Rule to determine eligibility for sample population submission. Not all measures allow sample population submission. Please see data collection guides for more detailed instructions.

Statewide Quality Reporting and Measurement System (SQRMS): State health reform law passed in 2008. Under this law with specific directives within Minnesota Statutes, section 62U.02, all physician clinics are required to register and submit data on measures to be publicly reported to the Commissioner of Health. To implement physician clinic registration and the collection of quality measurement data, MDH developed SQRMS, created through Minnesota Rules, Chapter 4654. MDH has contracted with MNCM to assist with implementing SQRMS. Under this contract, MNCM supports physician clinics in meeting registration and measure requirements.

Summary of Changes: Area at the beginning of each data collection guide which highlights changes from the previous year.

System Query: Process by which data elements are pulled from chart system (EMR or manual) by clinics/medical groups.

Total Population: Consists of the entire eligible population. Please refer to the specific data collection guides for further instructions on how to submit total population.

Two-Week Review Period: Period after data submission in which clinics/medical groups can review their preliminary results in comparison with other clinics/medical groups. This is a very important validation step to ensure accurate results before public reporting.

Urgent Care Clinics: A type of walk-in clinic, either stand-alone or offered as a service of a multispecialty clinic, that primarily treats illness or injuries requiring immediate care, but not serious enough to require an ER visit. Stand-alone urgent care clinics must register and complete an annual Health Information Technology (HIT) survey; however, urgent care clinics are not required to report on clinical quality measures.

Value Set: A set of administrative codes used to define a concept related to the measure construct (e.g. denominator, exclusions) using standard coding systems (e.g. ICD-10, CPT, LOINC).

Value Set Dictionary: A spreadsheet based list of codes by measure. Contains all Value Sets applicable to a given measure.

Warnings: The error and warning report is displayed in the MNCM Data Portal after data file submission. Warnings should be reviewed to determine if corrections are needed.